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3D-моделирование – шаг в будущее   

Применение компьютерной программной техники в современной жизни стало 

незаменимым. Огромное количество отраслей используют вычислительные 

машины для ускорения решения задач. Одним из перспективных направлений 

развития компьютерных технологий является создание трехмерной модели 

объекта (3Д-Моделирование ).Основной задачей 3Д-Моделирования являетс 

разработка визуального объема образа желаемого объекта ,который может быть 

как реальным , так и полностью абстрактным.  

Уже сегодня трехмерная графика активно применяется в науке , 

промышленности , медицине , компьютерных играх , кинематографе и других 

областях для визуализации происходящих процессов ,элементов знаний . 

деталий машин , механизмов и т.д. . что позволило значительно повысить 

эффективность производства. Например , до недавнего времени работу по 

созданию спецэффектов в кинематографии выполняли в специальных 

павильонах с использованием физических моделей, методов прозрачной 

фотографии и т.п., что занимало много времени и требовало привлечения 

большого количества людей и материалов. Теперь для решения этой проблемы 

достаточно посадить одного человека за персональный компьютер , на котором 

установлено программное обеспечение , позволяющее создать спецэффекты .  

На сегодняшний день разработано большое количество программ , 

позволяющих создавать трехмерные модели и объекты. Среди наиболее 

популярных можно можно назвать такие программы как, 3Dstudio Max2, 

Blender и Auto – Cad (применяются в основном инженерами проектировщиками 



для создания чертежей и пространственных моделей).  

Цвелью данного проекта является изучить программу Blender и разработать с 

помощью нее различные  3Д- модели. Для решения этой цели  ставятся 

основные задачи :изучить основные положения трехмерной компьютерной 

графики; изучить правила работы с программой Blender ; создать с помощью  

программы различные Blender трехмерные объекты. 

 

 I. Трѐхмерная компьютерная графика 

Трехмерная графика (3D (от англ. 3 Dimensions — «3 измерения») Graphics, Три 

измерения изображения) — раздел компьютерной графики, совокупности 

приемов и инструментов (как программных, так и аппаратных), 

предназначенных для изображения объѐмных объектов. 

3D-моделирование — это процесс создания трехмерной модели объекта. Задача 

3D-моделирования — разработать визуальный объемный образ желаемого 

объекта. С помощью трехмерной графики можно и создать точную копию 

конкретного предмета, и разработать новое, даже нереальное представление до 

сего момента не существовавшего объекта. 

Трехмерная графика - вид компьютерной графики, представляющий собой 

объемную модель какого-либо объекта. Для создания трехмерной модели 

требуются специальные программные и аппаратные средства. К программным 

принадлежат приложения 3D-визуализации. К аппаратным относят то, с 

помощью чего создается и отображается модель (компьютер, 3D-мониторы, 

3D-принтеры). 

Задача 3D-моделирования: разработать визуальный объѐмный образ желаемого 

объекта. При этом образ может как копией готового (известного) объекта, так и 

разработанный с нуля. 

Для создания трѐхмерной графики необходимо знать расположение объекта, 

которое определяется системой координат. Основной является декартовая 

система координат. 



В трѐхмерной системе координат 3D-3-dimensional оси обозначаются как X, Y, 

Z, причѐм Z ось перпендикулярна плоскости XY. В разных программах 

ориентация Z оси может быть различной. 

Местоположение объектов, выраженных по отношению к системе координат 

XYZ, называется мировой системой координат. 

Трехмерное изображение на плоскости отличается от двумерного тем, что 

включает построение геометрической проекции трѐхмерной модели сцены на 

плоскость (например, экран компьютера) с помощью специализированных 

программ (однако, с созданием и внедрением 3D- дисплеев и 3D-принтеров, 

трехмерная графика не обязательно включает в себя проецирование на 

плоскость). При этом модель может как соответствовать объектам из реального 

мира (автомобили, здания), так и быть полностью абстрактной (проекция 

четырѐхмерного фрактала). Для создания объѐмного изображения существует 

несколько подходов: 

1. От плоскости к объѐму (когда рисуют плоский объект и для создания 

трѐхмерного образа рассматривают объект с различных сторон также на 

плоскости, пример — чертежи). 

2. От объѐма к плоскости (в нѐм изначально создаѐтся трѐхмерный образ и для 

получения серии плоских картинок делают снимки этого трѐхмерного объекта с 

различных ракурсов, положений и т. д. Принцип реализуется в 3Ds Max, 

Cinema). 

II. Создание 3D объектов с помощь программы Blender 

  

                                             1. Общие положения         

Blender – это пакет для создания трѐхмерной компьютерной графики, 

включающий в себя средства моделирования, анимации, рендеринг, 

постобработку видео, а также создание интерактивных игр. 

Это бесплатное программное обеспечение для 3D-моделирования с 

открытым исходным кодом, доступное для всех основных операционных 

систем под Стандартной общественной лицензией GNU. Программа была 

разработана по заказу голландской анимационной студии NaN. 

Blender работает со слоями, так же как другие 3D программы.  Одной из 

сильных сторон Blender является способность программы работать с типами 

файлов, созданными в других 3D программах. 

Особенностью данной программы является то, что она 

разработана сообществом разработчиков open-sourcе и постоянно 

совершенствуется. 

С помощью программы  Blender  можно создавать 

различные 3D изображения, в том числе текст, в формате JPEG или 

видеоролики. 



2. Основные термины и определения 

Вершина является самым маленьким возможным объектом в блендере. 

Дальше идет грань – она состоит из двух связанных между собой вершин, 

которая тоже не отобразиться при рендере. И, наконец,  полигон – это 4 

соединенные между собой гранями точки. Пустое пространство 

между этими точками заполнено плоскостью – которая отображается при 

визуализации и имеет внешнюю и внутреннюю сторону. 

Рендеринг является процессом графического отображения 3D сцены или 

объекта. Такие возможности, как материалы, текстуры, 

освещение, oversampling и тени управляют эффектами и качеством рендера. 

Чем больше этих элементов добавлено, тем более реалистичной становится 

сцена. 

Материалы и текстуры характеризуют внешний вид объекта (цвет и 

структуру). Материалы придают объекту реализм с помощью различных 

эффектов, таких как блеск, световое излучение, прозрачность и т.п. 

Текстуры создают различные характеристики поверхностей, например: 

дерево, мрамор, облака, волны и неровность. Текстуры могут быть изготовлены 

из любой сканированной фотографии или нарисованного объекта в любом 

редакторе изображений, также может использоваться и видео. 

Освещение характеризуется наличием источников света, которые 

добавляют сцене необходимые световые эффекты с помощью различного типа 

отражений и теней. Можно управлять типом, интенсивностью, а так же цветом 

освещения и его пределами на определѐнном расстоянии. Кроме того можно 

создавать специальные эффекты, например эффект ореола при освещении 

тумана или пыли. 

Камера – это точка наблюдения сцены. Камера позволяет управлять 

длиной фокусного расстояния (объектива), настраивать область обзора и 

глубину резкости. Она может следовать за объектом по определенному пути, 

либо следить за объектом с установленной точки. 

Анимация – это серия изображений, формирующих видеоряд. 

Основными вариантами анимации являются изменение размеров объекта, его 

вращение и передвижение. На качество фильма влияют частота кадров в 

секунду (FPS), размер изображения, тип файла вывода и сжатие. 

Анимация в реальном времени позволяет добавлять объектам реальные 

физические свойства, а так же использовать клавиатуру и другие устройства 

ввода для управления объектами сцены. Можно создать персонажей (actor), 

изменять массу (mass), устанавливать трение (friction), силу и вращение в 

разных направлениях, создавать связи с другими объектами в сцене. 

3. Интерфейс Blender 

При запуске программы на мониторе компьютера отображается сцена, 

состоящая из куба, лампы и камеры (вид сверху) и окон (см. рис. 1). 



 
Рис. 1. Окно Blender 

  

Куб – стандартный меш-объект, созданный в этой сцене, для того, что бы 

сделав тестовый Рендер можно было увидеть на получившейся картинке 

объект, а не пустое изображение. Трехмерный курсор, находящийся в середине 

куба, используется для определения места, где будут добавляться другие 

объекты. 

В 3D окне можно наблюдать две пересекающиеся в центре линии 

(красную и зелѐную) – оси координат X и Y (их обозначения есть в нижнем 

левом углу 3D-окна), 3D-курсор, куб, лампу и камеру. 

Лампа служит источником света (без неѐ конечное изображение было бы 

чѐрным). 

Камера необходима для отображения конечного изображения. С 

помощью камеры мы видим изображение под тем или иным углом. 

Все вместе (куб, лампа, камера) формируют сцену – представление 

события. 

3D-курсор в центре куба используется для определения места добавления 

новых объектов. Вы можете перемещать его щелчком левой кнопки мыши. 

Теперь запомним следующую особенность: многие команды в Blender 

предпочтительно отдавать с клавиатуры. При этом следует помнить, что курсор 

мыши должен находиться именно в том дочернем окне, где планируется 

произвести изменения. 

4. Рендеринг 



Сцена, созданная в программе Blender – это далеко еще не изображение. 

Однако Blender можно использовать для создания 3D-графики. Чтобы получить 

из сцены графический файл необходимо «отрендерить» файл. 

Формирование изображения по созданной сцене называется рендерингом 

(отрисовкой). 

В Blender, чтобы посмотреть конечное изображение можно нажать F12. 

Отображаемая сторона, удалѐнность и др. на получившейся картинке зависят от 

того, где размещена и как повѐрнута камера. 

5. Навигация в окне просмотра с помощью клавиатуры 

Если после запуска Blender вы нажмѐте F12 и посмотрите на 

получившееся изображение, то, возможно, будете озадачены тем, что оно не 

совпадает с видом сцены (тем, что видим в 3D-окне). На самом деле все 

правильно, сцену вы видите сверху (так установлено по-умолчанию), а 

изображение получаете как вид из камеры (судя по всему камера ―смотрит‖ 

сбоку). 

Чтобы изменять вид в окне просмотра чаще всего используют клавиши 

NumPad (дополнительную цифровую клавиатуру). Например, для того, чтобы 

установить в 3D-окне вид из камеры следует нажать 0 (ноль). 

Назначение клавиш NumPad: 

0 – вид из камеры; 

1 – вид спереди; 

3 – вид справа; 

2, 4, 6, 8 – поворот сцены; 

5 – перспектива (повторное нажатие возвращает обратно); 

7 – вид сверху; 

«.» и Enter – изменение масштаба относительно выбранного объекта; 

«+» и «-» – изменение масштаба сцены 

6. Навигация в окне просмотра c помощью мыши 

Изменять вид окна просмотра можно не только с помощью клавиатуры, 

но и используя мышь: 

– прокрутка колеса мыши меняет масштаб; 

– движение мыши при нажатом колесе поворачивает сцену (не крутите 

его, просто нажмите как кнопку); 

– движение мыши при нажатом колесе + Shift передвигает сцену. 

Примечание. Курсор мыши должен находиться в 3D-окне (а то 

передвинете что-нибудь другое). 

7. Выделение, перемещение, масштабирование объектов 

Итак, первоначально на сцене присутствуют три объекта (куб, камера и 

лампа). Их можно передвигать, менять угол наклона и др., но для начала 

неплохо бы научиться выделять объекты (т.е. указывать компьютеру, с чем 

именно мы будем работать). 

Выделение объекта в Blender осуществляется щелчком правой кнопки 

мыши по нему. Контур выделенного объекта становится розовым. 



Чтобы выделить несколько объектов, надо щѐлкать по ним по очереди 

правой кнопкой мыши при зажатой клавише Shift. 

Если было выделено несколько объектов, нажатие клавиши A приводит к 

сбрасыванию выделения со всех объектов, а последующее нажатие - к 

выделению всех объектов. 

Прежде чем мы начнем изменять формы меш-объектов и превращать их в 

другие формы, мы должны хорошо освоить создание, перемещение, вращение и 

масштабирование основных меш-объектов. 

Основные способы модификации объектов: 

клавиша ―G‖ – перемещение или захват (Grab) объекта; 

клавиша ―S‖ – масштабирование (Scale) объекта; 

клавиша ―R‖ – вращение (Rotate) объекта. 

Например, чтобы изменить размер куба по всем осям с помощью 

клавиатуры необходимо выполнить следующую последовательность действий: 

1. Выделить куб; 

2. Нажать клавишу S, чтобы включить режим масштабирования; 

3. Перемещать курсор мыши, пока объект не достигнет необходимого 

размера; 

4. Щѐлкнуть левой клавишей мыши, чтобы согласиться с изменениями, 

или правой – чтобы отказаться от них. 

Если при перемещении курсора (п.3) зажать клавишу Ctrl, то любое 

изменение будет пошаговым (на определѐнную величину). 

Вместо нажатия клавиш G, R и S, вы можете использовать кнопки с панели 

Transform с левой стороны окна 3D-вида: Translate (G), Rotate (R), Scale (S). 

 
Рис. 2. Окно Трансформации объекта 

Если вы хотите использовать эти модификации с точными параметрами 

(например, повернуть объект по оси Х на 90 градусов или изменить размер на 

точное значение единиц) – нажмите клавишу “N” для открытия панели 

трансформации с правой стороны окна 3D-вида (или щелкните по символу ‖ + ‖ 

в правом верхнем углу окна). Здесь вы можете заблокировать изменение 

некоторых параметров. 



 
Рис. 3. Окно Трансформации объекта по точным данным 

  

Если Вы хотите переместить объект, введите команду перемещения ―G‖. 

Двигайте мышь, объект будет перемещаться вместе с мышью. 

Если изменения необходимо выполнить только по одной оси, можно 

пользоваться клавишами X, Y, Z. После клавиши S или др. следует нажать X 

или Y или Z, в зависимости от того, по какой оси требуется изменить объект. 

8. Сохранение и открытие файлов 

Сохранение и открытие файлов в Blender не сильно отличается от этих 

действий в других программах. Однако окна здесь выглядят достаточно 

специфично. Главное, что следует запомнить: в Blender при закрытии 

программы не выводится диалоговое окно с предложением сохранить файл. 

Поэтому об этом следует позаботиться заранее, иначе можно безвозвратно 

утратить только что созданный документ. 

III. Создание объекта «Пончик» с помощь программы Blender версии 2.8 
  Для создания объекта на ноутбук загружена программа Blender версии 

2.8. Эта версия оптимальна по системным требованиям для ноутбука с 

минимальными показателями ﴾64-битный двухъядерный процессор, 4 Гб 

оперативной памяти, видеокарта, размер памяти которой превышает 1 Гб), но 

имеет большой набор функций для создания трехмерных моделей. 

После открытия программы выделяем куб и  с помощью клавиши «Delete» 

удаляем его. 



   

Рис. 4. Открытие программы. 

На месте куба создаем кольцо: в верхней строке 

меню Add → Mesh → Torus. После появления кольца сразу обращаем на окно 

слева внизу Add Torus. Открываем его сразу и делаем настройки размера и 

количества полигонов, так как после щелчка мыши, к этим настройкам уже не 

вернутся. 

Major Radius 5cm 

Minor Radius 0,03 m 

Major Segments 28 

Minor Segments 12. 

 
Рис. 5. Создание кольца 

Кольцо получилось идеальным, но пончик не имеет идеальной формы, 

поэтому мы его будем деформировать. Выделяем его и задаем режим 

редактирования с помощью клавиши «Tab». В верхней строке меню 

выбираем Proportional Editing. На модели выбираем любую точку, нажимаем 

клавишу «G» и колесом мышки прокручиваем от себя. В верхней строке меню в 

разделе Proportional size будут меняться значения, останавливаемся на 0,03-

0,04. На экране должен появиться круг – область изменения модели. Теперь 

выбираем любую точку поверхности → G → зажимаем левую кнопку мыши. 



При движении мыши поверхность модели будет деформироваться.  Повторяем 

в нескольких областях «Пончика». 

 
Рис. 6. Деформация кольца 

  

Поверхность модели остается угловатой для пончика, надо ее 

сгладить. Tab → правая клавиша мышки → Shade Smooth. 

В окне слева находим иконку «Гаечный ключ» 

→ Add Modifier → Subdivision Surface. 

 
Рис. 7. Сглаживание кольца 

На данном этапе рекомендовано сохраниться. Для этого находим в верхней 

строке меню File → Save Ass → вводим название файла → Save. 

Далее делим фигуру «Пончик» на две части: пончик и глазурь. Tab → 

1 ﴾фронтальный вид) → Alt + Z ﴾режим рентгена) → выделить верхнюю 

половину объекта → Alt + Z → Shift + D ﴾дублировать) → Р ﴾Selection). 

Получили два объекта, что отражается в окне справа. 



 
Рис. 8.  Деление объекта на пончик и глазурь 

  

Следующим шагом делаем глазурь тоньше и приглаживаем ее к пончику. 

«Гаечный ключ» → Add Modifier → Solidify → Offset задаем 2 mm. Глазурь все 

еще отходит от пончика, чтобы она плотно прилегала, ставим на первое место 

в Add Modifier с помощью стрелок справа Solidify. 

Добавляем у глазури подтеки. Для дальнейших действий нужно «спрятать» 

объѐм глазури, нажав на режим редактирования Add Modifier, Solidify. Горячей 

клавишей «А» выделяем глазурь. Дальше увеличиваем количество полигонов: 

правой клавишей мышки открываем окно и выбираем Subdivide. В нижнем 

левом углу откроется окно, где задаем параметры: 

Number of Cuts – 1 

Smoothness – 1. 

 
Рис. 9.  Увеличение количества полигонов глазури 

Теперь выделяем внешнюю нижнюю границу глазури: Alt + левая клавиша 

мышки по ребру полигона, который составляет внешнюю нижнюю границу 

глазури. В верхней строке меню находим Select → Invert → H ﴾спрятать). 



 
Рис. 10.  Внешняя нижняя граница глазури 

Чтобы глазурь стекала по пончику, делаем «привязки»: 

1.     Горячие клавиши Shift + Tab, 

2.     Snapping → Face + Project Individual Elements 

3.     Proportional Editing, 

4.     Snap ﴾иконка «Магнит»). 

Выделяем точку на внешней нижней грани глазури → G → движением 

колѐсика мышки меняем область действия, а движением самой мышки меняем 

форму края глазури, но незначительно. Иначе она будет «проваливаться» в 

пончик. Для того чтобы глазурь стекала поверх пончика, выделяем 2-3 точки 

→ E → движение мыши вниз. 

С помощью масштабирования можем корректировать острие подтека: 

выделить точку→ S → область действия изменить с помощью мыши. 

 
Рис. 11.  Формирование подтеков глазури 

Переходим к модели пончика. Включаем режим редактирования. 

Увеличиваем количество полигонов пользуясь 

модификатором Subdivision Surface. Subdivision Surface → Viewport:2 + Apply. 

Переходим в режим скульптинга в верхней строке меню: Sculpting. 

Настраиваем размер кисти с помощью горячей клавиши «F» + движение мыши 

и силу нажатия  - «Ctrl» + «F» + движение мыши. Щелчком левой клавиши 

мыши подтверждаем. По внешней стороне пончика делаем вдавливание: Ctrl + 

нажатие левой клавиши мыши и ее движения. Затем уменьшаем размер кисти и 

силу вдавливания и повторяем вдавливание по периметру. Сглаживание и 



корректировку можно сделать с помощью Smooth на панели инструментов 

слева аналогичным образом. 

 
Рис. 12.  Скульптинг пончика 

С помощью классической кисти Draw сделаем вдавливание во внутренней 

стороне пончика по периметру. 

Возвращаемся к глазури. Для выхода из режима скульптинга нажимаем в 

верхней строке меню Layout  и повторяем работу с модификаторами как у 

пончика. Увеличиваем количество полигонов пользуясь 

модификатором Subdivision Surface. Subdivision Surface → Viewport:3 + Apply. 

                          Solidify → Apply. 

         Дорабатываем капли стекания глазури с помощью Inflate, чтобы они 

смотрелись более органично. Наращиваем с помощью кисти капли глазури. 

Сглаживание и корректировку можно сделать с помощью Smooth на 

панели инструментов слева аналогичным образом. 

Пользуясь кистью Draw и расширением радиуса действия, делаем 

неровности в рельефе глазури для естественного вида пончика. Следовательно, 

дорабатываем кистью Smooth, корректируем слишком большие неровности. 

 Завершающим этапом данной работы будет наложение цвета. Справа в 

окне меню выбираем Context. Material настраиваем параметры для каждого 

объекта: 

Base Color 

Subsurface – 0.3 

Specular – 0.6 

Roughness – 0.4 

С помощью горячей клавиши Z переходим в рендер, тогда пончик 

окрасится заданные цвета. 



 
Рис. 13. Наложение цвета на пончик 

  

Советы 

·                                 Добавляйте столько деталей, сколько вам 

нужно. Добавление слишком большого количества граней, ребер и вершин к 

объекту может замедлить работу компьютера и привести к длительному 

рендерингу. 

·                                 Прежде чем моделировать сложный объект, сначала 

нарисуйте вид объекта спереди и сбоку на миллиметровой бумаге. 

·                                 Как только вы закончите моделировать объект, 

попробуйте добавить к нему материалы и текстуры. 

Заключение 

Особенность современного этапа развития общества заключается в 

феноменальном прорыве цифровых технологий. На глазах одного поколения 

радикально изменилось отношение ко многим сторонам жизни. 

Возможности компьютерных технологий, позволяющие решать проектно-

композиционные задачи, инициировать творческий потенциал и способствовать 

формированию пространственного мышления. 

Компьютерное трѐхмерное моделирование, анимация и графика в 

целом не уничтожают в человеке истинного творца, а позволяют ему 

освободить творческую мысль от физических усилий, максимально 

настроившись на плод своего творения. 

Целью данной работы было выполнение трехмерной модели «Пончик». В 

ходе работы над проектом были выполнены все поставленные задачи. Гипотеза 

не подтвердилась. Для освоения программы Blender нужно гораздо больше 

времени. 

https://translated.turbopages.org/proxy_u/en-ru.ru.0e48e608-62fdcb6b-a547ae8f-74722d776562/https/www.wikihow.com/Apply-a-Material-or-Texture-in-Blender


Трудности возникли и с мощностью ноутбука. При наложении текстуры 

программа начала «зависать». Чем больше модификаций и полигонов, тем 

«тяжелее» становится файл. Для профессионалов актуально выбирать технику, 

которая соответствует оптимальным требованиям. К рекомендуемым 

параметрам относится: 4-ядерный 64-битный процессор; 16 Гб оперативной 

памяти; видеокарта с размером памяти от 4 Гб. 

Самостоятельно изучать программу сложно и долго, очень много 

нюансов. На профессиональном уровне пока невозможно заниматься графикой 

без определѐнных навыков, но технология не стоит на месте и, возможно, в 

недалѐком будущем творение человека будет зависеть только от его мысли. 

Программу Blender можно скачать бесплатно с сайта www.blender.org. 

 

 

 

 

 

 

 

http://www.blender.org/

